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PSC Inc. UPG Runtime
END USER LICENSE AGREEMENT

NOTICE TO END USER: PSC is providing you with a license for the Software you have acquired, subject to the terms and 
conditions of this Agreement.  If you use the Software, you will be deemed to have accepted the terms and conditions of this 
Agreement.  If you do not intend to be bound by the terms of this Agreement, PSC is not willing to license the Software to you, 
you may not use or copy the Software, and you must contact the party from whom you acquired the Software promptly for 
instructions.

This End User License Agreement ("Agreement") is a legally binding agreement governing the licensing of the Software by PSC Inc. 
and its wholly owned subsidiaries and affiliates ("PSC") to the entity or person who has acquired the Software ("End User"). For 
purposes of this Agreement, "Software" means the Runtime version of PSC's Universal Program Generator, whether obtained directly 
or indirectly from PSC, including any related update or upgrade such as enhancements or modifications, and including all 
accompanying documentation.  Any software that is associated with a separate end-user license agreement, including but not limited to 
the Full Development System version of the Universal Program Generator, is licensed to you under the terms of that license agreement.  
PSC and End User hereby agree as follows: 

1. Scope of License Granted.
1.1 PSC grants to End User a non-exclusive, non-transferable, perpetual license to use the Software, in machine-readable form only, 
solely for End User's internal business purposes.  This Agreement does not convey ownership of the Software to End User.  Title to the 
Software shall be and remain at all times with PSC or any third party from whom PSC has obtained a licensed right.  

1.2 End User shall not sell, assign, sublicense, distribute, lend, rent, give, or otherwise transfer the Software to any third party unless 
such third party agrees with PSC in writing to be bound by the terms and conditions of this Agreement.  Any such transfer of the 
Software absent such agreement shall be null and void.

1.3 Under no circumstances shall End User modify, decompile, disassemble, reverse engineer, or otherwise reproduce or remanufacture 
the Software, whether modified or unmodified, without PSC's prior written consent.

2. Intellectual Property.
End User acknowledges that the Software constitutes valuable trade secrets of PSC and that the Software is protected by intellectual 
property laws and treaties. The license set forth in this Agreement does not transfer to End User any ownership of PSC's copyrights, 
patents, trademarks, service marks, trade secrets, or other intellectual property rights and End User shall have no right to commence 
any legal action to obtain such rights.  End User shall not remove, modify, or take any other action that would obscure any copyright, 
trademark, or other intellectual property notices contained in the Software.

3. Proprietary Information.
3.1 "Proprietary Information" means all (a) source code, object code, software, documentation, and any related internal design, system 
design, data base design, algorithms, technology, technical data or information, implementation techniques, and trade secrets related to 
the Software, (b) any other trade secrets marked appropriately or identified as proprietary or confidential, and (c) any information that 
End User, under the circumstances, should recognize as confidential. Proprietary Information does not include any information that 
the receiving party can establish was (1) in the public domain, (2) already in the receiving party's possession or rightfully known prior 
to receipt, (3) rightfully learned from a third party not in violation of any other's proprietary rights, or (4) independently developed.

3.2 End User acknowledges that Proprietary Information is the confidential, proprietary, and trade secret property of PSC and End 
User acquires no right or interest in any Proprietary Information.  
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3.3 End User shall not disclose, provide, or otherwise make available PSC's Proprietary Information to any person other than End 
User's authorized employees or agents, all of whom must be under confidentiality agreement at least as restrictive as the terms of this 
Section 3, and End User shall not use the Proprietary Information other than in conjunction with use of the Software exclusively for 
End User's internal business purposes. End User shall take steps to protect the Proprietary Information no less securely than if it were 
End User's own intellectual property.

3.4 The provisions of this Section shall survive and continue for five (5) years after the termination of this Agreement.

4. Limited Warranty.
THE SOFTWARE IS PROVIDED "AS IS" AND PSC MAKES NO WARRANTIES OF ANY KIND, EXPRESS OR IMPLIED, 
WRITTEN OR ORAL, WITH RESPECT TO THE SOFTWARE, AND SPECIFICALLY DISCLAIMS THE IMPLIED 
WARRANTIES OF MERCHANTABILITY, NONINFRINGEMENT,  AND FITNESS FOR A PARTICULAR PURPOSE. 

5. Limitation of Liability.
PSC'S OBLIGATIONS AND LIABILITIES AND THE RIGHTS, CLAIMS, AND REMEDIES OF END USER SPECIFICALLY 
SET FORTH IN THIS AGREEMENT ARE EXCLUSIVE. UNDER NO CIRCUMSTANCES SHALL PSC BE LIABLE TO END 
USER OR TO ANY THIRD PARTY FOR LOST PROFITS, LOST DATA, INTERRUPTION OF SERVICE, OR FOR ANY 
SPECIAL, INCIDENTAL, INDIRECT, CONSEQUENTIAL, CONTINGENT, PUNITIVE, EXEMPLARY OR ANY OTHER 
DAMAGES, WHETHER BASED UPON CONTRACT, TORT (INCLUDING NEGLIGENCE), PRODUCT LIABILITY, 
STRICT LIABILITY, WARRANTY, OR ANY OTHER BASIS, EVEN IF PSC HAS BEEN ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES.

7.  Government Restricted Rights; International Use.
The Software is provided with Restricted Rights.  Use, duplication, or disclosure by the U.S. Government is subject to the restrictions 
for computer software developed at private expense as set forth in the U.S. Federal Acquisition Regulations at FAR 52.227-14(g), or 
52.227-19 or in the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013(c)(1)(ii), whichever is 
applicable.  If End User uses the Software outside the United States, End User must comply with the local laws of the country in which 
the Software is used, with U.S. export control laws, and with the English language version of this Agreement.  The provisions of the 
"United Nations Convention on International Sale of Goods" shall not apply to this Agreement.

8.  Termination.
8.1 Either party may terminate this Agreement or any license granted under this Agreement at any time upon written notice if the 
other party breaches any provision of this Agreement.

8.2 Upon termination of this Agreement, End User immediately shall cease using the Software and shall return to PSC or destroy all 
Software covered by this Agreement, and shall furnish PSC with a certificate of compliance with this provision signed by an officer or 
authorized representative of End User.  

9. General Provisions.
9.1 Entire Agreement; Amendment. This Agreement contains the entire agreement between the parties relating to the Software and 
supersedes all prior or contemporaneous agreements, written or oral, between the parties concerning the Software. This Agreement 
may not be changed, amended, or modified except by written document signed by an authorized representative of each party. 

9.2 Notice. All notices required or authorized under this Agreement shall be given in writing, and shall be effective when received, with 
evidence of receipt.   Notices shall be sent to End User at such address as End User shall provide to PSC in writing, and shall be sent to 
PSC  Attn: Contract Administration, PSC Inc., 959 Terry Street, Eugene, OR 97402. 

9.3 Waiver. A party's failure to enforce any of the terms and conditions of this Agreement shall not prevent the party's later 
enforcement of such terms and conditions. 

9.4 Governing Law. This Agreement shall be governed by the laws of the State of Oregon, United States of America, excluding choice 
of law provisions. 

9.5 Attorneys Fees. In the event an action is brought to enforce the terms and conditions of this Agreement, the prevailing party shall 
be entitled to reasonable attorneys' fees, both at trial and on appeal.

-END-
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Installing UPG Runtime

UPG Runtime System Requirements
UPG Runtime runs with the minimum requirements listed below, but for 
maximum performance, install UPG Runtime onto a computer with a 
higher speed processor and more memory than the minimum 
requirements.

Hardware • Processor - 80486/50MHz (Pentium recommended)
• Memory - 16MB (32 recommended)
• Hard Disk - 10MB
• Video - VGA

Operating
Systems

• Windows® 98 (SP 5)
• Windows® ME (SP 5)
• Windows® NT (SP 6)
• Windows® 2000 
• Windows® XP 
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Supported Portables
UPG Runtime supports the PSC Falcon, and some other DOS portables 
as listed below. A compatible docking station or communications cable is 
required for the portable data collection unit to work with UPG Runtime. 
Contact a portable data collection supplier to obtain the necessary 
portable accessories.

PSC • Falcon 31x
• Falcon 32x
• Falcon 33x
• Falcon 34x
• Falcon 51x

Brady • Brady DLT
• Brady DLT16

LXE • 2325
• MX2

NOTE

Visit PSC’s website at www.pscnet.com for up-to-date information on system 
requirements and a list of currently supported portables.

http://www.pscnet.com
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UPG Runtime Installation
Complete the following steps in the installation utility to install UPG 
Runtime: 

1. Select RUN from the Windows START menu.

2. Type a:\rtsetup.exe in the OPEN field and press the OK button, 
using the appropriate drive letter for the CD disk drive.

3. Select Next on the Welcome screen to continue the installation.

4. Select Yes, I Accept to accept the UPG Runtime license agreement at 
the UPG License Agreement screen.

5. Select the UPG Runtime destination directory; it installs to the 
C:\UPG directory by default. Select or create another directory if 
preferred.

6. Select the installation destination for installation of the UPG startup 
icon. 

7. Reboot the computer.

8. Launch the UPG Runtime. 

NOTE

By default, the UPG Runtime startup icon is placed in the Universal Program 
Generator program group. If preferred, select or create another startup group.
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Uninstalling UPG Runtime
To uninstall the UPG Runtime from the computer, complete the 
following steps:

1. Press the Windows START button.

2. Select PROGRAM.

3. Select Universal Program Generator, or the program group specified 
during installation.

4. Select UPG Runtime UNINSTALL.

5. Press the NEXT button to begin uninstalling UPG. This removes all 
of the installed components of UPG from the computer.

6. Reboot the computer to complete the uninstall process. 

The UPG directory may remain after uninstallation. Any projects that may 
have been built using UPG are saved in the \Projects subdirectory of 
UPG. In this case, the UPG directory is not removed to protect existing 
projects.

Launching UPG
1. Press the Windows START button.

2. Select PROGRAM.

3. Select Universal Program Generator (or the program group specified in 
step 6).

4. Select UPG Runtime.
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Overview of UPG Runtime
Welcome to the UPG Runtime User’s Guide. This manual explains how 
to program a portable and transfer data using UPG Runtime.

UPG Runtime allows end users of Universal Program Generator (UPG) 
generated programs to download programs, UPG Runtime Projects and 
data files to the Falcon PDT family portables without having UPG.   
More knowledgeable users can also use UPG Runtime to create and edit 
program UPG Runtime Project files, and parameter files used by the 
generated EXE and the PDT.

You can run UPG Runtime with or without command line parameters:

• You can download UPG Runtime projects, UPG Generated EXE 
files, and data files without command line settings. (Refer to UPG 
Runtime User Interface on page 6.) 

• Knowledgeable users can create and edit UPG Runtime project files 
and parameter files used by the generated EXE with /E command 
line settings. (Refer to UPG Runtime User Interface on page 6.) 

• Running UPG Runtime with the /? or /H command line settings 
displays the UPG Runtime help file. 

• Running UPG Runtime with a project filename automatically loads 
the project and starts the project file download process. (For 
example: upgrun sample.prj). (Refer to Figure 7 on page 11). 

• Other override commands include: 
• B# = Baud Rate 
• /# = Serial Port Number 
• /I = Product ID   (1-5=31x=1, 32x=2, 33x=3, 51x=4, 34x=5).
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UPG Runtime User Interface
UPG Runtime downloads UPG created programs and support files to the 
PDT. You may download an application, a project, or project files using 
UPG or by UPG Runtime. UPG Runtime can also transfer files between 
the host PC and the PDT.

UPG Runtime is a menu system. Main menu functionality is visible 
through command buttons. 

Figure 1: UPG Runtime User Interface



File Transfers &
Project Downloads

Chapter 2 Contents
Overview

File Transfers
Transmit Files

Receive Files
Host Mode

Project Downloads
Project

EXE
Help
Exit

Overview
This section covers the most used features of UPG Runtime: File 
Transfers and Project Downloads. Access these features with the 
command buttons in the UPG Runtime user interface.
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File Transfers

Transmit Files
1. Click on the Transmit Files button to send files to the portable.

Figure 2: Select File to Transfer Window 

2. Select a file to transfer and press Open.
• The File Transfer window opens.

Figure 3: File Transfer Window 

• After the file has been transmitted, the File Transfer window 
closes.
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Receive Files
1. Click on the Receive Files button to receive files on the portable.

Figure 4: Select File to Receive Window 

2. Select a file to receive and press Open.
• The Receive File window opens.

Figure 5: Receive File Window 

• After the file has been received, the Receive File window closes.
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Host Mode
Host Mode is a method of receiving files using the Z-Modem protocol. It 
continuously waits for files and receives them using the filenames specified 
by the sender. Once files have been received, it goes back to waiting for 
additional files. Click Cancel to quit Host Mode.

Figure 6: Host Mode Window 
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Project Downloads

Project
Use Project Downloads to download EXE and support files (*.INI or 
*.TXT) to the PDT.

1. Press the Project button to open the Load Project File window.

Figure 7: Load Project File Window 

2. Select a project file (*.prj) and press Open.

Figure 8: File List Window 
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3. The downloadable EXE file and directory are displayed with a list of 
files to download.
• Press Send.
• A dialog appears for actions to be performed on the PDT.

Figure 9: PDT Message Dialog Box

4. Type LD on the PDT and press Enter once.

Figure 10: Transmit File Window 

Each file in the list and the EXE is downloaded.
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EXE
If a UPG DOS EXE program does not have a project file, download the 
EXE directly by completing the following steps:

1. Press the EXE command button.
• A Download an EXE window opens.

Figure 11: Download an EXE Window 

2. Select an EXE file to download.

Figure 12: File List Window 
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3. The downloadable EXE file and directory are displayed with a list of 
files to download.
• Press Send.
• A dialog appears for actions to be performed on the PDT.

Figure 13: PDT Message Dialog Box

4. Type LD on the PDT and press Enter once.

Figure 14: Transmit File Window 

The EXE and each file in the list are then downloaded.

Help 
To access online Help, click on the Help button or press F1.

Exit
To exit UPG Runtime, click on the Exit button. 
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Edit Serial Settings Button
Before beginning to program or send data to and from the portable, open 
the Setup form to establish the communication settings for the host PC. 
Select Edit > Serial Settings from the menubar to open the form.

The Serial Settings form contains three tabbed sections: General, Transfer, 
and Logging. Detailed descriptions of each tabbed section follow.

Figure 15: UPG Runtime User Interface
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General Tab
Figure 16: File Transfer Setup Definition Form: General Tab 

Connection Enter the Connection port for file transfers. Select from the list of 
detected serial ports or modems. 

Baud Rate Select a Baud Rate for serial 
communications from the pull-down 
list. The default value is 19200.

Protocol Select the file transfer Protocol to 
use for sending and receiving files. 
The Protocol depends upon what 
the Host system requires. The 
default value is ZModem. 
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XModem XModem does not allow multiple file transfers.

ZModem ZModem allows multiple file transfers. 

ACK/NAK  ACK/NAK does not allow multiple file transfers. Do not use 
ACK/NAK with PSC Falcon DOS units.

Maximum Errors Enter the maximum number of Errors permitted before a file 
transfer is aborted. Range: 1 to 50. 0 specifies no limit to the 
number of file transfer errors.

Flow Control Select the mechanism used to 
control the flow of data. Sender and 
receiver must agree on the flow 
control method.

None No flow control used.

XON/XOFF Software flow control using XON and XOFF characters to 
communicate when to suspend and resume data transfer. Only 
available with Z-Modem protocol. 

RTS/CTS Hardware flow control that uses Ready to Send (RTS), and Clear 
to Send (CTS) serial port lines to communicate when to suspend 
and resume data transfer.

Window Size Specifies the amount of data 
transmitted before receiving a 
response from the receiver. 

Streaming Sender does not wait for a response before sending all the data. 

1024-4096 Causes the sender to wait for a response after sending the 
specified amount of data.

Crash Recovery Specifies whether or not an attempt 
is made to complete a file transfer 
at the point of failure.

Never Never attempts to recover from a file transfer.

Follow 
Sender

Follows the sender’s Crash Recovery and Overwrite options.

Always Forces an attempt to recover from a file transfer.
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Transfer Tab
This tab establishes file transfer settings. Select the Transfer tab.

Figure 17: Transfer Tab of the File Transfer Utility 

Sender Timeout 
(Seconds)

Enter the maximum number of seconds to wait for a 
connection when sending files. A value of 0 waits 
indefinitely.

Receiver Timeout Enter the maximum number of seconds to wait for a 
connection when receiving files. A value of 0 waits 
indefinitely.

Path/Filename 
Transmission

Enter a Path/Filename Transmission to control how the 
sender processes the paths and filenames of files to be sent. 
Only applies to Z-Modem.

Strip Path Sends only the filename (no path) to the receiver.

Send Path Sends the filename with path to the receiver.

Specify 
Receiver’s File 
Path/Name 

Allows both the filename and path for each file to be altered 
prior to being sent to the receiver.
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Overwrite Select to determine the action the receiver takes when a 
received file already exists.

Source Longer or 
Newer 

Overwrites the existing file if the received file is longer or 
newer.

CRCs Don’t 
Match 

Overwrites the existing file if the CRCs of both files don’t 
match.

Append Appends the received file to the existing one.

Always Overwrites the existing file with the one received.

Source Newer Overwrites the existing file if the received file is newer.

Date/Length 
Don’t Match 

Overwrites the existing file if the dates or lengths of both files 
don’t match.

Never Skips the transfer if the received file already exists.

File Transfer Default Enter the File Transfer Default folder for storing received 
files. Use the Browse button to locate a new location.
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Logging Tab
This tab establishes settings for the communications log. Click the 
Logging tab.

Figure 18: Logging Tab of the File Transfer Utility 

Log To File Specifies that the log is to be written to a text file.

Log To Screen Specifies that the log is displayed on screen. 

Append to Log This option becomes available when you select Log to File. When 
enabled, Append to Log adds log information to the end of the 
log file. If not enabled, new log information replaces the previous 
log file.

Log Path/
Filename 

Specify the location for storing the communications log. 
If a path is not given, the file is stored in the Default File Transfer 
folder. 

Browse Use the Browse button to locate a new log file.
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Menubar Overview
The menubar is located just under the top border of the UPG Runtime 
window. It consists of File, Product, and Help pull-down menus, which 
are each described in the following sections.

File Menu
Select File from the menubar. 

Figure 19: UPG Runtime File Menu 
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New Project
The New Project option is available when the edit switch is activated. 
Select File > New Project to create a new project. This opens a blank 
Project window.

Figure 20: New Project to Build 

Editing a File List or Filename

From the main menubar, select the File to modify the project file list. Files 
in the list can be edited, added, and deleted from the list.

Figure 21: Add Files Windows Dialog Box
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Select one file from the file list and change the Send As name or 
destination drive. 

1. Select a file to download to the portable. 
• Press the Open button.
• Press Cancel to cancel the operation.
• A dialog appears for actions to be performed on the PDT.

Figure 22: PDT Dialog message

2. Type LD on the PDT and press Enter once.

File menu Select File from the menubar. 

Add File Select Add File to display a standard Windows file dialog. Select 
multiple files to add. When the download window is redisplayed, 
the selected files appear the File column of the file list.

Edit File Select a file in the file list. Select File > Edit to edit the settings of 
the selected file. Refer to Edit Drive Window on page 26.

Delete File Select a file in the file list. Select File > Delete to delete the file 
from the list.

Get EXE Select File > Get Exe to create or modify a UPG project file from 
UPG Runtime. If running UPG Runtime, create new project. File > 
Get EXE becomes available. Use Get Exe to select a UPG 
generated EXE file using the standard Windows file dialog. The 
selected file will parse into the EXE and directory settings.

Exit Saves settings, closes the File List form, and returns the user to 
the UPG application.
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Figure 23: Receive File Status Dialog Box

3. The Send File Status dialog box opens.
• Press Close to stop the download.
• Press Help for more information.

Project Menu

The Project file format is
; Comment
/E Program Name
/D Default Text Drive Letter
/I App INI file location
/F Falcon Drive, delimiter (|), Filename
/P Falcon Port
/L Language exe, 

Project menu Select File from the menubar.

Load Select Load to load another project file. Use this to download the 
EXE with non-standard INI or text files. The first time you 
download the EXE, add the extra files and save the project. 
During subsequent downloads, load the previously saved project 
file rather than adding the files individually.

Save Saves the current settings to the currently opened project file. If 
the project file has not been previously saved, the Save As dialog 
box opens
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Figure 24: File List Definition Form 

Save As... Saves the current settings as a specified filename. A standard 
windows dialog box opens so that you can choose or enter a new 
project filename.

Copy Files & 
Save Project

Saves the current settings into a project file and then copies the 
project file, EXE, and support files to a new selected project file 
directory.

Baud Rate Baud rate to transfer the EXE and files in file list. The first time it is 
activated it will be the current baud rate from Host Settings. After 
first download view, the Host Settings baud rate changes will not 
affect download baud rate. This allows separation of baud rate 
transfers for downloading generic data files VS downloading of 
projects.

Language Shows what language is currently selected to run downloaded 
EXE. You can change the selection, however you should normally 
use UPG to set setting. Runtime users may need to use setting

EXE Name of program being downloaded.

Directory Directory where program is located.

File List of files to download. If path is not included then files are 
located in the same directory as the program.

PDT File Name of file on PDT. Some file names are automatically 
generated and cannot be changed by the user, specifically: 
(BPARAMS.INI, UPG.INI, <app>P.INI, and 
<app>.INI, if they are present on the list. If PDT File is left 
blank, the name becomes the filename (minus path).
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To edit a non-INI file and open the Edit Drive form, double-click on the 
file.

Figure 25: Edit Drive Window 

PDT Drive Name of drive the data file will reside on. Blank setting leaves the 
file at the default drive specified for the file type. INI files must 
the INI Drive setting.

Data Drive This is the default drive for the data files. It is also the drive from 
which the EXE is ran (the EXE is not stored on this drive).

INI Drives This is the drive location for all INI files, with the exception of 
BPARAMS.INI (the Falcon autoexec looks for this file on 
the C drive).

Send Sends files.

Cancel Select to cancel changes to current settings and return to the 
UPG application. 

NOTES

UPG will not let the name or drive of certain INI support files to be changed 
(For example: BPARAMS.INI, UPG.INI, <app>.INI, and <app>P.INI).

INI files cannot have the drive target changed file by file.

INI files can not be changed or have the INI drive overridden.

All files in the file list can be added or edited, not just INI files. 

Filename Enter a new path and filename. If the path is in the directory as 
the project, entering a path is optional

PDT filename Enter a new PDT filename for the file on the PDT.

Drive Click on the pull-down menu to edit the drive. 
Drive on PDT the file is to automatically be downloaded to.
If left blank then the data or INI data drive controls where the file 
is downloaded.
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Figure 26: Transferring File 

Exit
To quit UPG Runtime, select Exit from the File menu.

Product Menu
1. Select Product from the menubar.

Figure 27: UPG Runtime Product Menu
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2. Select a Portable Type, PDT Settings, or UPG EXE Settings to 
modify from the pull-down menu.

Portable Type
These are the known portables that UPG Runtime will correctly work 
with. 

PDT Settings
Refer to PDT Settings on page 29 for a complete description of PDT Settings.

UPG EXE Settings
Refer to UPG EXE Settings on page 53 for a complete description of UPG 
EXE Settings.

Help Menu

Help
The Help menu accesses the on-line help provided with the UPG 
Runtime application.

About UPG Runtime
This menu item provides information regarding the version of UPG 
Runtime and copyright information.

Falcon 31x (PSC) Default portable (PDT).

Falcon 32x (PSC)

Falcon 33x (PSC)

Falcon 34x (PSC)

Falcon 51x (PSC)

Symbol 3200

Brady DLT

LXE 2325

LXE MX2
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Overview
Select Product > PDT Settings from the menubar.

Figure 28: UPG Runtime Product Menu
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Base Default Setting for all ScanParameters
Figure 29: ScanParameters Definition Form

The setting controls the values for all the scan parameters in the PDT 
Settings definition form. Changing the value of this setting will update all 
fields in all scan parameters views to the new base default selected.

Descriptions and a view of each of the PDT Settings Definition form follow 
in the order they appear in the ScanParameters list.

Base Default Select an option from the Base Default pull-down list at the 
bottom right side of the form.

0 - All off
1 - All On
2 - Standard (default)
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ScanParameters: Codabar
Figure 30: ScanParameters: Codabar 

Enable Codabar Enables on all checkbox fields.

Enable Ames Enables on all checkbox fields.

Send Start/Stop Enables on all checkbox fields.

Wide Intercharacter Gaps 
Allowed

Enables on all checkbox fields.

CLSI Conversion Enables on all checkbox fields.

Minimum Length Minimum length for the bar code in order for it to scan. 
Click the up/down arrows or enter a whole integer into 
the field.

Maximum Length Maximum length for the bar code in order for it to scan. 
Click the up/down arrows or enter a whole integer into 
the field.
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ScanParameters: Code 11
Figure 31: ScanParameters: Code 11 

Enable Enables on all checkbox fields.

Require 2 Check Digits Requires two check digits for the bar code to scan.

Send Check Digits Includes the check digit in the scan string.

Minimum Length Minimum length for the bar code in order for it to 
scan. Click the up/down arrows or enter a whole 
integer into the field.

Maximum Length Maximum length for the bar code in order for it to 
scan. Click the up/down arrows or enter a whole 
integer into the field.
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ScanParameters: Code 128
Figure 32: ScanParameters: Code 128 

Enable Enables on all checkbox fields.

Enable UCC-128 Enables on all checkbox fields.

Minimum Length Minimum length for the bar code in order for it to 
scan. Click the up/down arrows or enter a whole 
integer into the field.

Maximum Length Maximum length for the bar code in order for it to 
scan. Click the up/down arrows or enter a whole 
integer into the field.
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ScanParameters: Code 39
Figure 33: ScanParameters: Code 39

Enable Enables on all checkbox fields.

Enable Checksum Enables on all checkbox fields.

Send Checksum Enables on all checkbox fields.

Full ASCII Mode Enables on all checkbox fields.

Minimum Length Minimum length for the bar code in order for it to 
scan. Click the up/down arrows or enter a whole 
integer into the field.

Maximum Length Maximum length for the bar code in order for it to 
scan. Click the up/down arrows or enter a whole 
integer into the field.
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ScanParameters: Code 93
Figure 34: ScanParameters: Code 93 

Enable Enables on all checkbox fields.

Minimum Length Minimum length for the bar code in order for it to 
scan. Click the up/down arrows or enter a whole 
integer into the field.

Maximum Length Maximum length for the bar code in order for it to 
scan. Click the up/down arrows or enter a whole 
integer into the field.
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ScanParameters: EAN/JAN
Figure 35: ScanParameters: EAN/JAN

Enable EAN/JAN Enables on all checkbox fields.

Enable EAN/JAN 13 Enables on all checkbox fields.

Convert EAN-13 to ISBN Enables on all checkbox fields.

Send Check Digit Enables on all checkbox fields.
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ScanParameters: Interleaved 2/5
Figure 36: ScanParameters: Interleaved 2/5 

Enable Enables on all checkbox fields.

Enable Checksum Enables on all checkbox fields.

Send Checksum Enables on all checkbox fields.

Lengths 6 & 14 only Enables on all checkbox fields.

Minimum Length Minimum length for the bar code in order for it to 
scan. Click the up/down arrows or enter a whole 
integer into the field.

Maximum Length Maximum length for the bar code in order for it to 
scan. Click the up/down arrows or enter a whole 
integer into the field.
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ScanParameters: Keyboard
Figure 37: ScanParameters: Keyboard 

Enable Ctrl+ALT+DEL Allows the user to use <CTRL>+<ALT>+<DEL> 
key combination to reboot the portable. Enables on 
all checkbox fields.

Enable Trigger Programmability Enables on all checkbox fields.

Double Action Key Mode Select one of the following:
Double Strike
Strike & Wait

Double Action Key Timeout Select from the pull-down list:
330 ms. (default)
385 ms.
440 ms.
495 ms.

NOTES

Double Action Key Mode and Double Action Key Timeout are both used to 
control keyboard entry on the Falcon 33x and 34x portables. 

For more information on Double Action Key Mode and Double Action Key 
Timeout, refer to the Falcon Portable DOS Terminal User’s Guide and the 
Falcon Portable DOS Terminal Advanced User’s Guide.
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ScanParameters: Label Code
Figure 38: ScanParameters: Label Code 

Enable Enables on all checkbox fields.

Convert Enables on all checkbox fields.
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ScanParameters: Matrix 2/5
Figure 39: ScanParameters: Matrix 2/5 

Enable Enables on all checkbox fields.

Enable Checksum Enables on all checkbox fields.

Send Checksum Enables on all checkbox fields.

Minimum Length Minimum length for the bar code in order for it to 
scan. Click the up/down arrows or enter a whole 
integer into the field.

Maximum Length Maximum length for the bar code in order for it to 
scan. Click the up/down arrows or enter a whole 
integer into the field.
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ScanParameters: MSI
Figure 40: ScanParameters: MSI

Enable Enables on all checkbox fields.

Require 2 Check Digits Requires two check digits for the bar code to scan.

2nd Check Digit Mod 11 Enables on all checkbox fields.

Send Check Digit(s) Includes the check digits in the scan string.

Minimum Length Minimum length for the bar code in order for it to 
scan. Click the up/down arrows or enter a whole 
integer into the field.

Maximum Length Maximum length for the bar code in order for it to 
scan. Click the up/down arrows or enter a whole 
integer into the field.
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ScanParameters: MSR
Figure 41: ScanParameters: MSR

Channel 1 Select one or both checkboxes to enable:

Enable Select to enable Channel 1.

Require Select to require Channel 1.

Channel 2 Select one or both checkboxes to enable:

Enable Select to enable Channel 2.

Require Select to require Channel 2.

Channel 3 Select one or both checkboxes to enable:

Enable Select to enable Channel 3.

Require Select to require Channel 3.

California Driver’s License ID

Alpha Conversion Select to enable Alpha Conversion.
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ScanParameters: Power
Figure 42: ScanParameters: Power

Backlight Auto-Off Timeout Number of seconds the backlight stays on if there 
is no other entry is made.

System Auto-Off Timer Number of seconds unit stays on with no activity. 
After the time has expired, the unit will shut off 
automatically.
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ScanParameters: Standard 2/5
Figure 43: ScanParameters: Standard 2/5

Enable Enables on all checkbox fields.
Enable Checksum Enables on all checkbox fields.
Send Checksum Enables on all checkbox fields.
Use 2 Bar Start/Stop Enables on all checkbox fields.
Minimum Length Minimum length for the bar code in order for it to 

scan. Click the up/down arrows or enter a whole 
integer into the field.

Maximum Length Maximum length for the bar code in order for it to 
scan. Click the up/down arrows or enter a whole 
integer into the field.
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ScanParameters: Scanner
Figure 44: ScanParameters: Scanner 

Good Read Tone Select the frequency for the tone that will sound 
when a barcode is scanned successfully. Select 
from the pull-down list: 2400 Hz (default), 2600 
Hz, 2800 Hz, 3000 Hz, 3200 Hz, 
3400 Hz, 3600 Hz, 3800 Hz.

Good Read Duration Select how long the good read tones will sound. 
Select from the pull-down list: short (default), 
medium short, medium long, long.

Auto Terminator Character Select the character to append to scanned data. 
Select from the pull-down list: (CR) Enter 
(default), Tab, None.

Number of Good Read Tones Select the number of times to sound the good read 
tone when a bar code is scanned. Select one of the 
following: 1 (default), 2, 3, or 4

Enable Scanner Programming Allows user to change parameter settings using bar 
codes provided in the Falcon Users’ Guide.

Send Symbology ID Includes symbology indentifying character as a 
prefix on scanned data.
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Enable Spotting Beam Allows the scanner to produce a spot (instead of a 
scan line) in order to aim the scanner. This is used 
for long range scanners.

Spot Beam Timeout Number of seconds the spotting beam stays active 
before changing to a scan line. 
Select from the pull-down list: 0.25, 0.50 
(default), 1.0, 1.5, 2.0.

Release Scan Beam Timeout Number of seconds the scan beam will continue 
without a good read before it shuts off.

Long Range Scanner Mode Controls how scanning is done when using a long 
range scanner. Select one of the following:
Release to Scan: Press the trigger to get a 
spotting beam. Release the trigger to scan.
Spot Beam Timeout: Press the trigger to 
get a spotting beam. Unit automatically scans after 
spot beam timeout expires.

NOTE

If the portable does not have a long range scanner, the spotting beam and 
other long range scanner settings are ignored.
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ScanParameters: Sound
Figure 45: ScanParameters: Sound 

Good Read Tone Select the frequency for the tone that will sound 
when a barcode is scanned successfully. Select 
from the pull-down list: 2400 Hz (default), 2600 
Hz, 2800 Hz, 3000 Hz, 3200 Hz, 
3400 Hz, 3600 Hz, 3800 Hz.

Good Read Duration Select how long the good read tones will sound. 
Select from the pull-down list: short (default), 
medium short, medium long, long.

Number of Good Read Tones Select the number of times to sound the good read 
tone when a bar code is scanned. Select one of the 
following: 1 (default), 2, 3, or 4

Error Tone Select the frequency for the predefined error tone. 
Select from the pull-down list: 2400 Hz, 2580 
Hz (default), 2770 Hz, 3000 Hz, 3270 Hz, 
3600 Hz, 3600 Hz, 4000 Hz, 4520 Hz.

Keyboard Sound Select the sound to be emitted when a key is 
pressed. Select from the pull-down list: Off, 
Click (default), Beep. 
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ScanParameters: UPC-A
Figure 46: ScanParameters: UPC-A 

Beeper Volume Select the volume level for the PDT speaker. Select 
from the pull-down list: Off, Quiet, Low, 
Medium Low, Medium, Medium High, 
High, Loud (default), One level higher, 
One level lower

Enable Enables on all checkbox fields.

Send System Digit Enables on all checkbox fields.

Send Check Digit Includes the check digits in the scan string.

Convert to EAN-13 Enables on all checkbox fields.
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ScanParameters: UPC-E
Figure 47: ScanParameters: UPC-E 

Use System Digit 0 Enables on all checkbox fields.

Use System Digit 1 Enables on all checkbox fields.

Convert to UPC-A Enables on all checkbox fields.

Send Check Digit Includes the check digit in the scan string.

Send System Digit Enables on all checkbox fields.
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ScanParameters: UPC Extensions
Figure 48: ScanParameters: UPC Extensions

Allow 2-Digit Extensions Select checkbox to enable.

Allow 5-Digit Extensions Select checkbox to enable.

Require Extensions Select checkbox to enable.
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ScanParameters: Video
Figure 49: ScanParameters: Video

Click OK after defining each ScanParameter. Or, click Cancel to exit 
without saving changes.

Backlight Auto-Off Timeout Number of seconds the backlight stays on if there 
is no other entry is made.
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Select Product > UPG EXE Settings from the menubar.

Figure 50: UPG Runtime Product Menu
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General Tab
Figure 51: UPG EXE Settings Definition Form: General Tab 

General The General section controls the basic or general properties of 
the UPG application. 

Allow Quit 
on Ctrl+C

Select to allow user to press <CTRL>+<C> to exit from DOS from 
any location when running on the portable.
When running in a Windows DOS box, this setting is ignored and 
<CTRL>+<C> is always allowed.
Enable this setting when testing the application on the portable. 
Disable it when distributing the application.

Upper Case 
Input Only

Select to force all alpha characters to upper case everywhere in 
the EXE program. The default is disabled.
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Number 
Keys on 
Menu

Specifies whether or not the number keys on the portable can 
function as <F> keys on menus. For example, if the menu has an 
<F8> hotkey, instead of pressing <F8> on the portable, press 8 on 
the number pad to execute the <F8> feature. 

This also allows single letter to function as <CTRL> letter combi-
nation. For example: if the menu has a <CTRL>+<M> hotkey, 
instead of pressing <CTRL>+<M>, press <M> alone.
Select to enable allowing number keys on the menu in the EXE 
program.

Hide Cursor Select to hide the blinking cursor in the EXE program.

Yes Keys Specify which keys can be pressed to enter a Yes value at a 
Yes/No prompt. UPG defaults to +1Y, which means the user can 
either press the <+>, <1>, or <Y> keys to enter a Yes value. Edit 
Yes Keys to modify which keys can be pressed for a Yes value.

Text Enter a value to display when the user receives a Yes prompt, 
such as when confirming an operation. Default value is Y.

No Keys Specify the keys to press to enter a No value at a Yes/No prompt. 
UPG defaults to -0N, which means the user can either press the 
<->, <0>, or <N> keys to enter a No value. Edit No Keys to modify 
which keys can be pressed for a No value.

Text Enter a value to display when the user receives a No prompt, such 
as when declining an operation. Default value is N.

Date/Time 
Formats

Allows definition of 10 character date and time formats. 

Date Sets the date format used within the portable application (affects 
both entered values and time stamping). UPG defaults to the 
Standard US date format (%m/%d/%y).
To use European date formats, change to %d/%m/%y. Use an 
uppercase Y to specify a 4-digit year (%m/%d/%Y).

Time Enter the Time format. Sets the time format used with the portable 
application (affects both entered values and time stamping). UPG 
defaults to %H:%M:%S. 
To exclude the seconds from the time format, edit to: %H:%M.

Text No longer in use.

True No longer in use.

False No longer in use.

Miscellaneous
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ESC Key 
Name

No longer in use. A hold-over from when <ESC> was not labeled: 
<ESC>.

ESC Count Enter the number of times <ESC> must be pressed in order to exit 
the form. Use this option to provide a hidden mechanism for devel-
opers and administrators to exit forms that you do not wish users 
to be able to exit. A value of 0 disables the <ESC> key.

Protocol Defines what protocol to use for a transfer session. -z is used for 
ZModem and -x is used for XModem.

Shell to DOS This option controls how the file transfer application 
(XFER.EXE) is executed.
Enable this checkbox to temporarily unload the application before 
executing the file transfer. This may be necessary with large 
applications if there is insufficient memory to run the file transfer 
with the application still loaded into memory.
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Serial Tab
By default, UPG uses the transfer program XFER on the Falcon PDT. 
However, there are situations when the user must use property transfer 
programs. Along with the transfer program name, UPG must know the 
command line flags in order for the program to function.

Figure 52: UPG EXE Settings: Serial Tab

Direct The Direct section of the UPG.INI file contains information 
about direct serial communications (using a cable instead of a 
modem). Select a value from the pull-down list:

COM Port Sets the portable COM port to be 
used for direct connect file transfer 
sessions between the portable and 
host. 
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Baud Rate Sets the baud rate for file direct 
connect transfer sessions between 
the portable and host PC. UPG 
defaults to the most reliable transfer 
rate based on the target portable 
selected in the Portable menu. If 
this entry is modified, check the 
portable hardware documentation 
for supported baud rates. 

Modem The Modem section contains information about modem 
communications.

COM Port Sets the COM port to be used for 
modem file transfer sessions 
between the portable and host.

Baud Rate Sets the baud rate for modem file 
transfer sessions between the 
portable and host PC. Defaults to 
the most reliable transfer rate 
based on the target portable 
selected in the Portable menu. 
Check the portable hardware 
documentation for supported baud 
rates. 

Transfer Program 
Cmds

Enter the option as it would be 
entered on the DOS 
command line.
The default settings are those 
used by XFER. Refer to the 
Falcon Portable Data 
Terminals Advanced User’s 
Guide (available at 
www.pscnet.com) for more 
information on XFER and 
applying transfer program 
flags.

http://www.pscnet.com


Serial Tab

User’s Manual                            59

EXE Name Specifies the name of the communications utility to be used for 
transferring files between the portable and host PC. UPG defaults 
to XFER. (Extension not required.) Change the XFER Program 
entry according to an added transfer utility: XFER supports 
ZModem and XModem.

Flow This flag specifies the flow control to be used. It is ignored if 
XModem is being used. /f1 (default).
Flow control is a mechanism by which the sender and receiver of 
serial data coordinate their communication. The receiver has to let 
the sender know when it is ready to receive data. This can be done 
in software (XON/XOFF) or in hardware (RTS/CTS). Software flow 
control uses two characters - XON and XOFF. When the receiver 
cannot accept data because buffers are full or other activities are 
taking precedence, it transmits an XOFF character to tell the 
sender to stop. When the receiver is ready to accept data again, it 
transmits an XON character to tell the sender to resume sending 
data. Hardware flow control uses two lines (RTS and CTS) in the 
serial cable. When the sender wishes to send data it activates the 
Request to Send (RTS) line. If the receiver is ready to receive data 
it activates the Clear to Send (CTS) line. 
The Falcon 33x and 34x portables do not have RS-232 serial ports 
with RTS and CTS lines. Therefore, RTS/CTS flow control is not 
available to these portables.

Baud Do not include the baud rate in this field. The baud rate will be 
appended to this option when the command line is created.
/b (default)

Port / (default)

Send The send flag used for the communications utility. /-t (default).

Receive The receive flag for the communications utility. /-r (default).

Host The host mode flag. /-r (default).

Overwrite This specifies the overwrite flag. 

Always This flag specifies that a file will overwrite an existing file. /o 
(default)

Never This flag specifies that a transferred file will not overwrite an 
existing file. /o7 (default)

Other This parameter is used to specify additional parameters.
/w1024 /e200 (default)
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Modem 
Connection 
Settings & Cmds

The default settings specify a 
1024 byte window size and 
specify a maximum error 
count of 200. 
Enter the options as it would 
be entered on the DOS 
command line.

NOTE

Modem connections depend upon modem speed and are 
usually much slower than a direct connection. Achievable 
modem baud rates may be much lower than the rate selected 
based upon telephone line conditions (static or “noise” 
causes the modem to lower the baud rate to compensate for 
poor line conditions).

Use Modem 
File

This parameter indicates that a modem configuration file will be 
used. Enter the name of the file in the MDM File Name field. If no 
modem configuration file is specified, this parameter is ignored. 
Default = /i

Modem This flag enables modem communications. XFER uses -m to 
activate the modem.

MDM File 
Name

Enter the name of the modem configuration file you wish to use.

Dial Code Enter the dialing string (using standard AT commands) that the 
portable application should use to initiate a modem connection 
with a host PC. Defaults to ATDT.

Auto Answer Enter the answer string (using standard AT commands) that the 
portable application should use to receive a modem connection 
with a host PC. Defaults to ATS0=1.

Telephone 
Number

Enter the phone number that will be dialed by the portable when 
using a modem to initiate a communications session to a host PC.

Modem 
Configu-
ration

Enter AT modem control codes if you don’t wish to use a modem 
configuration file. Refer to your modem’s user’s manual.
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For more information on XFER, refer to XFER.EXE in the Falcon Portable 
DOS Terminal Advanced User’s Guide. 

NOTE

If only a direct connection is used, it is not necessary to modify any of the 
modem settings.
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NOTES



A
always overwrite 59
auto answer 60

B
base default setting, scanparameters 31
baud 59

rate 58
baud rate

direct 58
Brady DLT 28

C
COM, modem port 58
commands

modem 60
transfer program 58

configuration
modem 60

connection
modem commands 60
modem settings 60

count, ESC 56
Ctrl+C

allow quit 54
cursor, hide 55

D
date

format 55
dial code 60
direct 57

baud rate 58
COM port 57

download
EXE 13
projects 11

E
editing a file list/name 22
ESC

count 56
key name 56

EXE 13
download 13
file list 13
name 59

exit 14, 27

F
Falcon 2
Falcon 31x 28
Falcon 32x 28
Falcon 33x 28
Falcon 34x 28

INDEX
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Falcon 51x 28
false text 55
file

list 11, 13
load project 11
MDM 60
menu 21
receive 9
transfer 8
transfers 8, 15
transmit 12, 14
use modem 60

file list
editing 22

filename
editing 22

files
receive 9
transmit 8

flow 59
format

date 55
time 55

G
General Tab 54

H
Hardware Requirements 1
help 14, 28

menu 28
hide cursor 55
host

mode 10
transfer program commands 59

I
input

upper case only 54

K
key, ESC 56
keys

no 55
number on menu 55
yes 55

L
launching UPG 3
LD 12, 14
Logging Tab 20
LXE 2325 28
LXE MX2 28

M
Memory 1
menu

file 21
help 28
number keys 55
product 27

Menubar 21
mode

host 10
modem 58, 60

auto answer 60
COM port 58
configuration 60
connection commands 60
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connection settings 60
dial code 60
MDM file 60
telephone number 60
use file 60

N
name

ESC key 56
never overwrite 59
no keys 55
no text 55
number keys on menu 55

O
other overwrite 59
overview 1
overwrite 59

always 59
never 59
other 59

P
PDT message dialog box 12, 14
PDT settings 29
port 59

direct COM 57
modem COM 58

portables
Brady DLT 28
default 28
Falcon 2
Falcon 31x 28
Falcon32x 28
Falcon33x 28

Falcon34x 28
Falcon51x 28
LXE 2325 28
LXE MX2 28
supported 2
Symbol 3200 28
type 28

product
menu 27

program commands, transfer 58
project 11

downloads 11
project file

load 11
protocol 56
PSC Falcon 2

Q
quit, allow on Ctrl+C 54

R
rate

baud 58
receive

file 9
files 9
transfer program commands 59

run UPG 3
runtime

about 28
overview 1
user interface 6, 7

S
ScanParameters
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base default setting 31
Codabar 32
Code 11 33
Code 128 34
Code 39 35
Code 93 36
EAN/JAN 37
Interleaved 2/5 38
Keyboard 39
Label Code 40
Matrix 2/5 41
MSI 42
MSR 43
Power 44
Scanner 46
Sound 48
Standard 2/5 45
UPC Extensions 51
UPC-A 49
UPC-E 50
Video 52

send
transfer program commands 59

serial settings 15
edit 15

Serial Tab 57
settings

PDT 29
UPG EXE 54

shell to DOS 56
software

requirements 1
starting UPG 3
supported portables 2

Falcon 2
Symbol 3200 28
System Requirements 1

T
telephone number 60
text

false 55
no 55
true 55
yes 55

time format 55
transfer

file 8
transfer program commands 58

baud 59
EXE name 59
flow 59
host 59
port 59
receive 59
send 59

Transfer Tab 18
transmit

file 12, 14
files 8

true text 55

U
UPG EXE

settings 54
upper case input only 54
user interface 6, 7

X
XFER 60, 61

Y
yes keys 55
yes text 55
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